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Introduction 

Atmel® SAM W25 includes the Atmel 2.4GHz IEEE® 802.11 b/g/n Wi-Fi 

ATWINC1500 along with SAM D21 ARM® Cortex® M0+ based MCU. This getting 

started guide describes the SAM W25 Wi-Fi module to build state-of-the-art 

Internet of Things (IoT) applications. This guide explains hardware information 

and how to install Atmel Studio (IDE), compile examples and download Wi-Fi 

network controller’s firmware. 

The following topics will be covered: 

 How to get Atmel Studio (IDE) and install it 

 Update new ASF package 

 Target board information 

 How to get weather client example project 

 How to get log message 

 How to download firmware and certificate 

Features 

 Hardware Prerequisites 

– Atmel SAM W25 Xplained Pro Evaluation Kit 

– Atmel IO1 extension 

– Micro-USB cable (Micro-A / Micro-B) 

 Software Prerequisites 

– Atmel Studio 

– Weather client example project source code 
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Icon Key Identifiers 

 Delivers Contextual Information About a Specific Topic 

 Highlights Useful Tips and Techniques 

 Highlights Objectives to be Completed 

 Highlights the Expected Result of an Assignment Step 

 Indicates Important Information 

 Highlights Actions to be Executed Out of the Target 
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1 Getting Started with Atmel Studio 

1.1 Download and Install Atmel Studio6.2 

Atmel Studio 6 is the integrated development platform (IDP) for developing and debugging Atmel ARM Cortex-

M and Atmel AVR® microcontroller (MCU) based applications. The Atmel Studio 6 IDP gives you a seamless 

and easy-to-use environment to write, build and debug your applications written in C/C++ or assembly code. 

Atmel Studio 6.2 is now available, adding advanced debugging features such as Data and Interrupt Trace, 

improved RTOS integration, and better ability to debug code that has been optimized. 

With the introduction of Atmel Gallery and Atmel Spaces, Atmel Studio 6 further simplifies embedded MCU 

designs to reduce development time and cost. Atmel Gallery is an online apps store for development tools and 

embedded software. Atmel Spaces is a cloud-based collaborative development workspace allowing you to host 

software and hardware projects targeting Atmel MCUs. 

 

Download and install Atmel Studio 6.2 from http://www.atmel.com/microsite/atmel_studio6/. 

You can find the installed directory: C:\Program Files\Atmel\Atmel Studio 6.2. 

1.2 Download and Install the Latest ASF 

Atmel Studio 6 is free of charge and is integrated with the Atmel Software Framework (ASF)—a large library of 

free source code with 1,600 ARM and AVR project examples. ASF strengthens the IDP by providing, in the 

same environment, access to ready-to-use code that minimizes much of the low-level design required for 

projects. Use the IDP for our wide variety of AVR and ARM Cortex-M processor-based MCUs, including our 

broadened portfolio of Atmel SAM3 ARM Cortex-M3 and M4 Flash devices. 

If the ASF version in your Atmel Studio is not the latest one you will be notified when Atmel Studio starts. The 

following procedure demonstrates how to update the ASF to the latest version. You can install other extensions 

in the list as well. 
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1. Run Atmel Studio 6.2. 

 

2. You can see the start page of Atmel Studio 6: 

 

3. Update ASF to the latest version. 

Menu → Tools → Extension Manager 

 
Available Downloads → Updates → Atmel Software Framework 
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4. Select an extension and proceed with download and installation. 

 

 Restart Atmel Studio to take effect of newly installed extension. 

1.3 Download and Install the latest ATWINC1500 Extension Package (Not yet released in 

Atmel Gallery) 

ATWINC1500 Extension package contains the ATWINC1500 software (latest firmware, firmware update tools 

and example projects). 

 As an Atmel Studio Extension (.vsix file), which can be found on the Atmel Gallery 
web site (http://gallery.atmel.com/) or using the Atmel Studio Extension manager. 

1. Atmel Studio → Menu → Tools → Extension Manager. 

2. Input “winc” in the search window then you can find the ATWINC1500 extension. 

3. Select the extension and proceed with download and installation. 

 



 

Platform Getting Started Guide for SAM W25 Xplained Pro [USER GUIDE] 
Atmel-42433A-SAMW25-Xplained-Pro-Getting-Started-Guide_UserGuide_052015 
6

 

6 

 Restart Atmel Studio to take effect of newly installed extension. 

4. Restart Atmel Studio. 

5. Open the Tools and Document via File → New → Example Project (Ctrl + Shift + E). 

 

6. Input “FIRMWARE” in the search window then you can find an example named like 

“WINC1500_FIRMWARE_UPDATE_AND_DOCUMENTATION”. 

  

This project contains documentation and tools to upgrade Wi-Fi network controller’s firmware to the specific 

version which is matched up with the Wi-Fi driver in example projects. It also contains documentation on how 

to run example projects in this extension. 
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2 Getting Started with Atmel Hardware 

This chapter introduces Atmel Evaluation Kits for testing IoT applications. The SAM W25 is essential but the 

IO1 extension board and the OLED1 extension board are optional. 

2.1 Atmel SMART SAMW25-XPRO Evaluation Kit 

The Atmel | SMART SAM W25 Wi-Fi module is based on the industry-leading Atmel ATWINC1500 low-power 

Wi-Fi 2.4GHz IEEE 802.11 b/g/n SoC (System on Chip) and the latest Atmel ARM Cortex-M0+ microcontroller 

technology. 

This turnkey system provides an integrated software solution with application and security protocols such as 

TLS, integrated network services (TCP/IP stack) which are available through Atmel Studio 6 integrated 

development platform (IDP). 

 

 Turnkey system with integrated software that includes TLS 1.0 and a TCP/IP stack WPA2 personal and 

enterprise security 

 Single-band 2.4GHz IEEE 802.11 b/g/n Wi-Fi ATWINC1500 

 Atmel | SMART ARM Cortex M0+-based SAM D21; 256KB Flash; 32KB SRAM 

 Serial Peripheral Interface (SPI) 

 Over-the-air updates 

 ATECC108A CryptoAuthentication™ engine with ultra-secure hardware-based key storage for secure 

connectivity 

 Extreme low power 

 Compact footprint: 33.8 x 14.9mm 

 Operating Voltage: 2.7 to 3.6V 

 Worldwide acceptance: FCC (USA), CE (Europe) and TELEC 

 RoHS compliant 

 Network services – DHCP, DNS, TCP/IP (IPv4), UDP, HTTP, HTTPS 

Here is the link for more detailed information about SAM W25: 

http://www.atmel.com/tools/atsamw25.aspx 
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2.2 Atmel IO1-XPRO Sensor Extension Board 

Atmel IO1 Xplained Pro extension board is a generic extension board for the Xplained Pro platform. It connects 

to any Xplained Pro standard extension header on any Xplained Pro MCU board. The extension board utilizes 

all functions on the standard Xplained Pro extension header to further enhance the feature set of Xplained Pro 

MCU boards. 

 

 microSD card connector 

– 2GB microSD card included 

– Accessed with SPI interface 

 PWM 

– LED control 

– PWM → Low pass filter → ADC 

 ADC 

– PWM → Low pass filter → ADC 

– Light sensor 

 UART 

– Loopback interface via pin header 

 TWI 

– AT30TSE758 Temperature sensor with EEPROM 

 Xplained Pro hardware identification system 

Here is the link for more detailed information about AT IO1: 

http://www.atmel.com/images/atmel-42078-io1-xplained-pro_user-guide.pdf 

2.3 Atmel OLED1-XPRO Display Extension Board 

Atmel OLED1 Xplained Pro is an extension board to the Atmel Xplained Pro evaluation platform. The board 

enables the user to experiment with user interface applications with buttons, LEDs and a display. 
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 UG-2832HSWEG04 monochrome OLED display 

– 128 x 32 Pixels 

– Controlled by 4-wire SPI interface, up to 100MHz 

 Three LEDs 

 Three Mechanical push buttons 

 Xplained Pro hardware identification system 

Here is the link for more detailed information about AT OLED1: 

http://www.atmel.com/images/atmel-42077-oled1-xplained-pro_user-guide.pdf 
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3 Getting Started with IoT Examples 

This chapter introduces IoT examples and describes how to run an example on the SAM W25 board. 

3.1 Organization of IoT Examples 

All of these examples are included in ASF Package and there are various IoT examples using Wi-Fi module. 

Basic Examples 

These examples describe basic Wi-Fi operation in ‘how-to’ manner: 

 How to read chip ID (to identify H/W revision of Wi-Fi controller) 

 How to set debug message level 

 How to get MAC address of the Wi-Fi module 

 How to start Wi-Fi in specific operation mode, such as: 

– STA Mode (Station mode), AP mode (Access Point mode), P2P mode (client mode) 

 How to switch mode among STA, AP, and P2P modes during the runtime 

 How to scan APs nearby 

 How to set deep sleep mode 

 How to connect to secure Wi-Fi with using WEP/WPA/WPA2 security 

 How to connect to enterprise security network 

 How to connect to security WPS 

 How to set packet monitoring 

 How to get RF signal status by reading RSSI value 

 How to set AP provision 

 How to set HTTP provision 

Protocol Examples 

After basic code examples, user may be interested in how to send and receive network packets. Here are 

protocol examples that can be extended for IoT application. 

 UDP protocol example 

 TCP protocol example 

 NTP Time client – retrieve network time for IoT application 

 MQTT protocol client example 

 Send email – send an email from SMTP server 

 Location client – get the current location of the network provider using HTTP 

Advanced Examples 

These examples demonstrate more complex function like: 

 Growl client – demonstrates using RESTful API over SSL (essential for IoT application) 

 MQTT Chat client – demonstrate how to send and receive IoT information using MQTT protocol 

 Weather client – get the current weather information of the network provider and utilize the IO1 sensor 

device 

 Wi-Fi serial - useful for chatting or controlling a remote device 

 OTA Firmware Upgrade – Wi-Fi network controller’s firmware upgrade via OTA server 

 SSL connection - Set up an SSL connection 
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3.2 Connect the Board 

The SAM W25 Wi-Fi module comes with a Wi-Fi software API. The purpose of this API is to provide an 

abstraction of the binary protocol used between the host processor and the Wi-Fi network controller while 

keeping an easy and reliable solution to add wireless capabilities to any user application. This software is 

based on the Atmel Software Framework (ASF). 

 

 Connecting an additional ATWINC1500 Wi-Fi modules on extension headers is possi-
ble but not supported by the provided Wi-Fi Software API. 

Connect the DEBUG USB port on the SAM W25 to your PC using a micro-USB cable. The SAM W25 will be 

visible in the Windows® Device Manager with its COM port. 

   

DEBUG USB 
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Atmel Studio may detect your device automatically and show a proper page. 

  

3.3 How to Get Weather Client Example Project 

This example demonstrates the use of the SAM W25 Xplained Pro board to receive weather information from a 

weather server. It uses the following hardware: 

 The SAM W25 Xplained Pro 

 The IO1 on EXT1 header 

 A wireless access point 

 A mobile device (for provisioning) 

          

Weather Server 
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1. Open the Weather client example via File → New → Example Project (Ctrl + Shift + E). 

 

2. Input “WEATHER” in the search window then you can find an example named like 

“SAMW25_XPLAINED_PRO_WEATHER_CLIENT_EXAMPLE”. 
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3. Press OK button then Atmel Studio will bring over the project source code of the example. 

 

3.4 How to Build and Execute 

This guide demonstrates how to build an example and execute it on the SAM W25 Xplained Pro. 

1. Build the solution (F7) and ensure you get no errors. 

 

2. Connect the IO1 extension to the SAM W25 Xplained Pro as displayed below: 

 

3. Connect the SAM W25 Xplained Pro board to your PC using DEBUG USB connector. 

4. Program the application by clicking on the Start Debugging and Break icon. 

 

DEBUG USB 
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5. You may be asked to select your debug tool: 

 

6. Select EDBG and SWD (Serial Wire Debug) as Interface: 

 

7. Click again on the Start Debugging and Break icon: 

 

8. The application will be programmed in the SAM W25 embedded flash and breaks at main function. Click 

on Continue to execute the application: 
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 You may be asked to upgrade your EDBG firmware. If so, click on Upgrade button: 

 

 Upgrade operation may take a few minutes, wait for the operation to complete. 

 The example is now programmed and running. 

Open the SAM W25 EDBG DEBUG USB serial COM port, with the following settings: 

 115200 bauds 

 8 bit data 

 no parity 

 one stop bit 

 and no flow control 

Open a serial terminal tool to see the result. You can use your preferred serial terminal, such as PuTTY, Tera 

Term, etc. You can also use terminal window plug-in in Atmel studio. You can install it through below menu. 

(Menu → Tools → Extension Manager) 

Connect to the device. 
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 Following information will be displayed on the terminal window. 

-- Weather client example -- 

-- SAMW25_XPLAINED_PRO -- 

-- Compiled: xxx xx xxxx xx:xx:xx – 

Provision Mode started. 

Connect to [atmelconfig.com] via AP[WINC1500_D4:84] and fill up the page. 

3.5 Provisioning 

As seen in the log message, the device is waiting for provisioning. In this stage, Wi-Fi network controller will 

run as AP mode, waiting for the user to setup a credential for a desired Access Point to use. 

Some examples have this kind of provision function while some don’t. It depends on the scenario of demo’s 

purpose. To setup a desired AP: 

1. Connect your mobile device to SAM W25 in Wi-Fi Setting. 
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2. Browse the webpage (atmelconfig.com) for setting AP, fill up the page then press Connect button. 

 

3. Then SAM W25 will run as a client and connect to the AP which you selected (the mobile device will be 

disconnected from your SAM W25). 

4. After the network is online, device will communicate with the weather server. The weather info will be 

printed on the terminal window. 

Wi-Fi IP is xxx.xxx.xxx.xxx 

wifi_cb: M2M_WIFI_RESP_PROVISION_INFO. 

Wi-Fi connected 

Wi-Fi IP is xxx.xxx.xxx.xxx 

Host IP is 144.76.102.166 

Host Name is openweathermap.org 

City: Seoul 

Weather Condition: sky is clear 

 

Temperature from sensor : 27 degrees 

Temperature from server : 3 degrees 

Temperature difference : 24 degrees 

 It may not be operated normally if the server connection is unstable. 
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4 How to Debug Wi-Fi Firmware 

 

SAM W25 Xplained Pro board provides UART interface for debugging. You can connect the SAM W25 

Xplained Pro board to your PC using a USB-to-Serial device and a debug USB connector to get firmware 

debug information. 

Open the SAM W25 DEBUG USB serial COM port, with the following settings: 

 115200 bauds 

 8 bit data 

 no parity 

 one stop bit 

 and no flow control 

Open a serial terminal tool to see the result. (Wi-Fi Firmware Debug information). 

(1)Chip ID = 1502b1 

(1)Flash ID = c21320c2, Size = 4 MBit 

(1)Working Image offset = 0x3000 Rollback =  0x40000 

(2)(M2M)(Efuse) successfully loaded from bank 1. 

(2)EFUSE:MAC 

(2)(M2M)MAC_ADDR  = F8:F0:05:20:AE:BF 

(3)NMI M2M SW  VERSION 18.0 

(3)NMI MIN DRV VERSION 18.0 

(3)Built at Jan 19 2015 23:48:51 

(3)__ROM_FIRMWARE__ 

(4)(M2M)LOAD SEC 

(6)(M2M)1000 400 2f000 2fc00 38000 

(7)(M2M)Wifi Connect 

(7)(M2M)SSID    : NW01 

(7)(M2M)AUTH    : WPA-Personal 

(7)(M2M)PSK     : nmisemi2 

(8)(M2M)Channel : 256 

  

DEBUG UART 

Wi-Fi driver version and 

Firmware version 
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5 How to Download New Firmware for Wi-Fi Network Controller 

As Wi-Fi host driver is coupled with Wi-Fi network controller firmware, so you have to match up the firmware 

version with the host driver version. You can check these versions via firmware debug message when the 

device is booted up. 

5.1 Download Firmware 

This section demonstrates the use of the SAM W25 Xplained Pro board to upgrade firmware of the Wi-Fi 

network controller. This is a basic operation to download firmware. It uses the following hardware: 

 The SAM W25 Xplained Pro 

Connect the SAM W25 (DEBUG USB PORT) to the USB port on your PC. 

 Do not connect SAM W25 VIRTUAL COM PORT via terminal program. 

 

1. Go to “WINC1500_FIRMWARE_UPDATE_AND_DOCUMENTATION” project directory. (Refer to 

Download and Install the latest ATWINC1500 Extension Package) 

2. Launch the batch file. 

\src\samw25_xplained_pro_firmware_update.bat   
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 SUCCESS firmware download. Following information will be displayed on the com-
mand window. 

SAMW25 flashing script: please connect edbg and power up the board. 

Firmware check OK 

Chiperase completed successfully 

Firmware check OK 

Programming completed successfully. 

Mode UART 

Can not find image_builder path... 

Downloading Image... 

******************************************** 

*  >Programmer for WINC1500 SPI Flash<     * 

*      Owner:  Atmel Corporation           * 

******************************************** 

>>Init Programmer 

Detecting ports... 

EDBG Virtual COM Port(COM4) 

(APP)(INFO)WINC1500 Serial Bridge Found 

Avail port COM4 

1 of ports found 

 

. . . 

 

>Start erasing... 

Done 

#Erase time = 4.633000 sec 

>Start programming.. 

Done 

#Programming time =6.661000 sec 

 

Image downloaded successfully. 

 

>>This task finished after 11.42 sec 

OK 

    ####################################################################### 

##                                                                   ## 

##                 ########     ###     ######   ######              ## 

##                 ##     ##   ## ##   ##    ## ##    ##             ## 

##                 ##     ##  ##   ##  ##       ##                   ## 

##                 ########  ##     ##  ######   ######              ## 

##                 ##        #########       ##       ##             ## 

##                 ##        ##     ## ##    ## ##    ##             ## 

##                 ##        ##     ##  ######   ######              ## 

##                                                                   ## 

####################################################################### 

Downloading ends successfully 
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 FAILED firmware download. Following information will be displayed on the command 
window. 

SAMW25 flashing script: please connect edbg and power up the board. 

Firmware check OK 

Chiperase completed successfully 

Firmware check OK 

Programming completed successfully. 

Mode UART 

Can not find image_builder path... 

Downloading Image... 

******************************************** 

*  >Programmer for WINC1500 SPI Flash<     * 

*      Owner:  Atmel Corporation           * 

******************************************** 

>>Init Programmer 

Detecting ports... 

EDBG Virtual COM Port(COM4) 

(APP)(ERR)[nm_bus_port_detect][567]Failed to find any COM ports 

0 of ports found 

(ERR)Failed To intilize programmer 

Fail 

    ####################################################################### 

##                                                                   ## 

##                    ########    ###     ####  ##                   ## 

##                    ##         ## ##     ##   ##                   ## 

##                    ##        ##   ##    ##   ##                   ## 

##                    ######   ##     ##   ##   ##                   ## 

##                    ##       #########   ##   ##                   ## 

##                    ##       ##     ##   ##   ##                   ## 

##                    ##       ##     ##  ####  ########             ## 

##                                                                   ## 

####################################################################### 

If you see a failed message, you must check your device is assembled correctly. 

 You must check terminal program. Do not connect SAM W25 VIRTUAL COM PORT 
via terminal program. 

 

Retry firmware download again. 
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5.2 Download Certificate File 

You need a certificate to set up a TLS connection and Wi-Fi firmware resource contains some root certificate 

files. This guide demonstrates how to download certificate files. It is similar to Firmware download. 

It is assumed that you already have your “Test_Root.cer” file. 

1. Go to “WINC1500_FIRMWARE_UPDATE_AND_DOCUMENTATION” project directory. (Refer to 

Download and Install the latest ATWINC1500 Extension Package) 

2. Go to \src\firmware\Tools\root_certificate_downloader\crt. You can find some cer files in the directory. 

(FreeRadius_Root.cer, NMA_Root.cer, PROWL_Root.cer, Radius_Root.cer.) 

Copy your “Test_Root.cer” file. 

(FreeRadius_Root.cer, NMA_Root.cer, PROWL_Root.cer, Radius_Root.cer, Test_Root.cer.) 

3. Modify the bat file as below. Find the “RootCertDownload.bat” file in 

\src\firmware\Tools\root_certificate_downloader\debug_uart. 

 

or 

 

4. Launch the batch file. 

\src\samw25_xplained_pro_certificate_update.bat. 

 SUCCESS certificate download. Following information will be displayed on the com-
mand window. 

... 

Start erasing... 

Done 

#Erase time = 0.047000 sec 

>Writing the certificate to SPI flash 

>Start programming.. 

Done 

#Programming time = 0.093000 sec 

Done 

All certificates have been downloaded 

If you see a failed message, you must check your device is assembled well and retry downloading again. 
  

root_certificate_downloader -n 5 NMA_Root.cer PROWL_Root.cer RADIUS_Root.cer 
FreeRADIUS_Root.cer Test_Root.cer -port 0 

root_certificate_downloader –n 1 Test_Root.cer -port 0 
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6 Conclusion 

This document explained essential part of evaluation kit and an example of use of the Atmel SAM W25 Wi-Fi 

module. 

The following topics have been covered: 

 How to get Atmel Studio (IDE) and install it 

 Update new ASF package 

 Target board information 

 How to get weather client example project 

 How to update firmware, certificates and getting log message 

You have seen how to use the SAM W25 Wi-Fi module and manage module software up-to-date. It is essential 

part of utilizing the other SAM W25 resources. 
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